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Formula	to	combine	multiple	worksheets	into	one.	How	can	i	combine	multiple	worksheets	into	one.	How	to	combine	multiple	worksheets	into	one	workbook.	How	do	i	combine	data	from	multiple	worksheets	into	one.

When	it	comes	to	merge	or	combine	multiple	worksheets	/	workbooks	or	csv	files	into	one	workbook,	most	of	us	will	think	about	copying	and	pasting	the	worksheets	into	one	workbook.	But	if	there	are	lots	of	worksheets	need	to	be	merged	by	such	way,	it	will	waste	much	time.	Kutools	for	Excel	augments	Excel	this	powerful	feature	–	Combine.	With
this	utility	you	can	easily:	Merge	/	combine	multiple	worksheets	or	workbooks	into	one	workbook	Supposing	you	have	Workbook	A,	Workbook	B	and	Workbook	C,	and	you	want	to	merge	or	combine	all	worksheets	of	those	workbooks	into	one	workbook.	You	can	get	it	done	as	follows:	1.	Please	apply	the	Combine	Worksheets	utility	by	clicking	Kutools
Plus	>	Combine.	Click	OK	in	the	following	popping	up	Kutools	for	Excel	dialog.	2.	In	the	Combine	Worksheets	wizard,	please	select	Combine	multiple	worksheets	from	workbooks	into	one	workbook	option,	and	then	click	Next	button.	See	screenshot:	3.	All	the	opened	workbooks	and	corresponding	worksheets	are	listed	in	the	Workbook	list	and
Worksheet	list	boxes,	you	can	click	Add	>	Files…	or	Folder…	button	to	add	the	workbooks	that	you	want	to	merge.	See	screenshot:	Tips:	A.	Add	workbooks	to	merge	Click	Files…	under	Add	button,	you	can	add	one	workbook	or	multiple	workbooks	into	Workbook	list.	If	you	click	Folder…	and	specify	a	folder,	all	workbooks	in	the	specified	folder	are
added	into	Workbook	list	at	once.If	you	click	Folder…,	it	will	automatically	add	all	workbooks	in	a	specific	folder	into	Workbook	list	to	merge.If	you	click	OneDrive	Files	or	OneDrive	Folder,	it	will	automatically	add	one	or	multiple	OneDrive	files	from	one	folder	or	different	folders	as	you	need.	B.	Remove	workbooks	from	the	Workbook	list	box	You	can
click	the			button	to	remove	a	workbook	from	the	Workbook	list	box.	Click	the	Remove	all	button	can	remove	all	workbooks	from	the	Workbook	list	box	at	once.	C.	Open	workbooks	which	has	been	encrypted	with	password:	If	you	want	to	combine	the	workbooks	which	has	been	encrypted	with	passwords,	please	click	the	Password	button.	In	the
Password	Manager	window,	click	the	Add	button,	enter	the	workbook	password	into	the	Password	textbox,	fill	in	the	label	and	click	the	OK	button.	At	the	same	time,	you	can	display	the	workbook	name	and	path	as	you	need.	Repeat	the	operation	until	all	workbooks’	passwords	are	added	to	the	manager,	and	then	click	the	OK	button	to	close	the
window.	See	screenshot:	D.	Save	or	access	one	scenario	of	your	operation:	If	you	want	to	save	the	settings	of	Step	2	in	Combine	Worksheets	for	future	operations,	click	Scenario	>	Save…	button,	and	then	name	the	scenario	in	the	popping	up	dialog.	By	doing	so,	you	don’t	need	to	add	workbooks	or	specify	the	worksheets	again	and	again	in	the	future,
you	just	need	to	click	the	Open	button	to	choose	the	scenario	item	you	have	saved.Besides,	you	can	click	the	Manage	button	to	get	into	the	Manage	Scenario	window	to	manage	the	saved	scenarios	as	you	need.	E:	Sort	all	listed	workbooks	and	worksheets	in	the	dialog:	From	the	Sort	drop	down	lists,	you	can	sort	the	listed	workbooks	or	worksheets	as
your	need.	F.	What’s	the	Same	sheet	button?	At	the	bottom	of	the	Worksheet	list,	there	is	a	Same	sheet	button.	With	this	button,	you	can	easily	select	all	worksheets	with	same	worksheet	name	across	all	the	checked	workbooks	in	the	Workbook	list.	For	example,	there	are	3	workbooks	that	have	been	checked	in	the	Workbook	list,	if	you	click	on	the
Sheet3	as	shown	in	the	below	screenshot,	it	will	immediately	select	all	worksheets	with	same	worksheet	name	across	the	3	checked	workbooks	after	clicking	Same	sheet	button.	See	screenshots:	Every	Sheet3	in	each	checked	workbook	has	been	checked	4.	After	adding	and	specifying	the	workbooks	and	worksheets	you	want	to	combine	or	merge,
please	click	the	Next	button.	In	the	Step	3,	please	configure	following	options:	5.	Click	Finish	button	to	merge	the	worksheets,	after	combining	the	sheets,	a	Specify	the	file	name	and	location	for	the	combined	workbook	window	is	popped	out,	you	can	specify	a	file	name	and	location	for	your	combined	file,	and	then	click	the	Save	button.	See
screenshot:	Note:	If	you	haven't	saved	the	workbook	and	worksheet	settings	as	scenario,	a	Kutools	for	Excel	window	will	pop	up	to	remind	you	to	save	the	scenario.	If	you	decide	to	save	it,	click	the	Yes	button	and	name	it	in	the	next	Save	Scenario	dialog.	Otherwise,	click	the	No	button.	See	screenshot:	A	new	workbook	is	created	and	status	of	the
combined	workbooks	are	listed	inside.	You	can	click	the	Output	file	link	to	open	the	combined	workbook	directly.	Then	multiple	worksheets	or	workbooks	have	been	combined	into	a	new	workbook.	In	the	new	workbook,	there	will	be	a	worksheet	which	names	Kutools	for	Excel,	and	it	contains	detailed	information	about	the	new	workbook	as	shown	in
the	below	screenshot.	Note:	If	you	think	the	Combine	feature	is	useful,	you	can	click		button	to	share	it	to	your	friends.	Do	you	want	to	know	how	to	merge	or	combine	all	same	name	worksheets	from	different	workbooks	into	one	worksheet?	Please	refer	to	Quickly	merge	/	combine	all	worksheets	of	same	name	across	workbooks	into	one	worksheet.
Demo:	Quickly	merge	/	combine	worksheets	/	workbooks	or	csv	files	into	one	workbook	in	Excel	Productivity	Tools	RecommendedThe	following	tools	can	greatly	save	your	time	and	money,	which	one	is	right	for	you?Office	Tab:	Using	handy	tabs	in	your	Office,	as	the	way	of	Chrome,	Firefox	and	New	Internet	Explorer.Kutools	for	Excel:	More	than	300
Advanced	Functions	for	Excel	2021,	2019,	2016,	2013,	2010,	2007	and	Office	365.	Kutools	for	Excel	The	functionality	described	above	is	just	one	of	300	powerful	functions	of	Kutools	for	Excel.	Designed	for	Excel(Office)	2021,	2019,	2016,	2013,	2010,	2007	and	Office	365.	Free	download	and	use	for	60	days.											No	ratings	yet.	Be	the	first	to	rate!
Dies	ist	eine	kostenlose	Web-App	zum	Kombinieren	mehrerer	Excel-Dateien:	Kombinieren	zu	PDF,	DOCX,	PPTX,	XLS,	XLSX,	XLSM,	XLSB,	ODS,	CSV,	TSV,	HTML,	JPG,	BMP,	PNG,	SVG,	TIFF,	XPS,	MHTML	und	Abschlag.	Führen	Sie	Excel	online	von	Mac	OS,	Linux,	Android,	iOs	und	überall	zusammen.	Verschmelzen	XLS,	XLSX,	XLSM,	XLSB,	ODS,
CSV,	TSV,	HTML,	HTM,	MHT,	MHTML,	NUMBERS	Im	gewünschten	Format	speichern:	PDF,	XLS,	XLSX,	DOCX,	PPTX,	XLSM,	XLSB,	ODS,	CSV,	TSV,	HTML,	JPG,	BMP,	PNG,	SVG,	TIFF,	XPS,	MHTML,	MD	Schnelle	Möglichkeit,	mehrere	Excel-Tabellendateien	zusammenzuführen	Kombinieren	Sie	verschiedene	Dateiformate	zu	einem	Dokument	einfach
als	PDF,	Bilder	oder	HTML	speichern	Führen	Sie	OpenDocument-Tabellenkalkulationsdateien	zusammen	Wählen	Sie	die	Reihenfolge	der	zusammengeführten	Dateien	Führen	Sie	Excel-Dateien	in	mehrere	Blätter	oder	ein	einzelnes	Blatt	zusammen	If	you	ask	people	who	work	with	data,	you	will	get	to	know	that	combining	Excel	files	or	merging
workbooks	is	a	part	of	their	daily	work.A	simple	an	example:	Let’s	say	you	want	to	create	a	sales	report	and	you	have	data	of	four	different	zones	in	four	different	files.The	very	first	thing	you	need	to	do	is	to	combine	those	files	in	one	single	workbook	and	only	then	you	can	create	your	report	further.The	point	is:	You	have	to	have	a	method	which	you
can	use	for	merging	these	files.	Say	“YES”	in	the	comment	section	if	you	want	to	know	the	best	method	for	this.Today	in	this	post,	I’m	going	to	share	with	you	the	best	way	to	merge	data	from	multiple	Excel	files	into	a	SINGLE	workbook.This	post	will	teach	you	something	you	need	to	learn	to	use	in	the	real	world	data	problem	so	make	sure	to	read
the	entire	post.Power	Query	is	the	best	way	to	merge	or	combine	data	from	multiple	Excel	files	in	a	single	file.	You	need	to	store	all	the	files	in	a	single	folder	and	then	use	that	folder	to	load	data	from	those	files	into	the	power	query	editor.	It	also	allows	you	to	transform	that	data	along	with	combining.It	works	something	like	this:Saving	All	the	Files
into	a	Single	FolderCombining	them	using	Power	QuerMerging	Data	into	a	Single	TableMake	sure	to	download	these	sample	file	from	here	to	follow	along	and	check	out	this	tutorial	to	learn	power	query.Note:	For	combining	data	from	different	Excel	files,	your	data	should	be	structured	in	the	same	way.	That	means	the	number	of	columns	and	their
order	should	be	the	same.To	merge	files,	you	can	use	the	following	steps:	First	of	all,	extract	all	the	files	from	the	sample	folder	and	save	that	folder	at	the	desktop	(or	wherever	you	want	to	save	it).	Now,	the	next	thing	is	to	open	a	new	Excel	workbook	and	open	“POWER	Query”.	For	this,	go	to	Data	Tab	➜	Get	&	Transform	Data	➜	Get	Data	➜	From
File	➜	From	Folder.	Here	you	need	to	locate	the	folder	where	you	have	files.	In	the	end,	click	OK,	and	once	you	click	OK,	you’ll	get	a	window	listing	all	the	file	from	the	folder,	just	like	below.	Now,	you	need	to	combine	data	from	these	files	and	for	this	click	on	“Combine	&	Edit”.	From	here,	the	next	thing	is	to	select	the	table	in	which	you	have	data	in
all	the	workbooks	and	yes,	you’ll	get	a	preview	of	this	at	the	side	of	the	window.	Once	you	select	the	table,	click	OK.	At	this	point,	you	have	merged	data	from	all	the	files	into	your	power	query	editor	and,	if	you	look	closely	you	can	see	a	new	column	with	the	name	of	the	workbooks	from	which	data	is	extracted.	So,	right-click	on	the	column	header
and	select	“Replace	Values”.	Here	in	the	“Value	to	Replace”	enter	the	text	“.xlsx”	and	leave	“Replace	With”	blank	(here	idea	is	to	remove	the	file	extension	from	the	name	of	the	workbook).	After	that,	double	click	on	the	header	and	select	“Rename”	to	enter	a	name	for	the	column	i.e.	Zone	.	At	this	point,	your	merged	data	is	ready	and	all	you	need	is	to
load	it	into	your	new	workbook.	So,	go	to	the	Home	Tab	and	click	on	the	“Close	&	Load”.	Now	you	have	your	combined	data	(from	all	the	workbooks)	into	a	single	workbook.This	is	the	moment	of	JOY,	write	“Joy”	in	the	comment	section	if	you	love	to	use	“Power	Query	for	combining	data	from	multiple	files”.In	the	above	steps,	we	have	used	the	table
name	to	combine	data	from	all	the	files	and	add	all	of	it	into	a	single	workbook.	But	not	all	time	you	will	have	the	same	table	name	in	all	the	Excel	files	and	at	that	point,	you	can	use	the	worksheet	name	as	a	key	to	summarizing	all	that	data.As	I	said,	you	can	use	a	worksheet	name	to	combine	data	with	the	power	query	but	there	are	few	more	things
which	I	want	to	share	with	you	and	you	need	to	take	care	of	those.	Power	Query	is	case	sensitive,	so	when	combining	files	make	sure	to	have	the	name	of	worksheets	in	all	the	workbooks	in	the	same	letters.The	next	thing	is,	to	have	the	same	name	for	the	column	headers,	but	here	the	kicker:	The	order	of	the	columns	doesn’t	matter.	If	column1	in	the
north.xlsx	is	column2	in	the	west.xlsx,	Power	Query	will	match	it,	but	you	have	to	have	column	names	the	same.So	now,	while	combining	files	using	power	query	you	can	use	the	worksheet	name	instead	of	the	table	name,	and	here	you	have	"SalesData"	as	the	worksheet	name	in	all	the	files.You	select	it	and	click	on	the	"Combine	&	Edit"	and	follow	all
the	steps	which	I	have	mentioned	in	the	above	method.Yes,	I’m	a	huge	fan	of	Power	Query	and	you’ll	be	if	you	get	to	know	this:Once	you	create	a	query	which	combines	data	from	multiple	workbooks	into	one,	you	don’t	need	to	do	it	again	and	again.If	you	add	new	files	to	that	your	folder,	you	just	need	to	refresh	the	table,or,	use	the	refresh	button.And
the	power	query	will	update	your	table	and	you’ll	get	all	the	data	into	the	table	from	all	the	workbook	you	have	in	that	folder.If	combine	files	manually	or	even	by	any	other	method	then	it	takes	time	for	you	to	copy-paste	data	into	a	single	table.But	power	query	does	it	in	the	background	and	you	don't	need	to	spend	a	second	extra.…that	in	some



situations,	you	won’t	have	the	same	name	for	worksheets	and	not	all	the	data	in	tables	all	the	time.Now,	what	you	should	be	doing	in	that	case?…in	this	case,	you	must	know	how	you	can	combine	data	from	all	the	files	and	I	don’t	want	to	miss	to	share	with	this	thing	with	you....so	without	any	further	ado,	let's	get	started.First	of	all,	open	the	“From
Folder”	dialog	box	to	locate	the	folder	where	you	have	all	the	files.Now	in	this	dialog	box,	locate	the	folder	and	click	OK.After	that,	click	on	the	“Edit”	to	edit	the	table.At	this	point,	you	will	have	a	table	like	below	in	your	power	query	editor.Next,	select	the	first	two	columns	of	the	table	and	click	on	the	“Remove	Other	Columns”	from	the	right-click
menu.From	here,	we	need	to	add	a	custom	column	to	fetch	data	from	the	worksheets	of	the	workbooks.For	this,	go	to	Add	Column	Tab	and	click	on	the	“Custom	Column”	button.	This	will	open	the	“Custom	Column”	dialog	box.In	the	dialog	box,	enter	=Excel.Workbook([Content])	and	click	OK.…at	this	time	you	have	a	new	column	in	the	table	but	next,
you	need	to	extract	data	from	it.Now,	open	the	filter	from	that	newly	added	custom	column	and	click	OK	to	expand	all	the	data	into	the	table.Here	you	have	the	newly	expanded	table	with	some	new	columns.Now	from	this	new	table,	delete	all	the	columns	except	third	and	fourth.So,	open	the	filter	for	the	column	“Custom.Data”	to	expand	it	and	click
OK.The	moment	you	click	OK,	you’ll	get	all	the	data	from	all	the	files	into	a	single	table……you	need	to	make	some	changes	into	it	to	make	it	PERFECT.If	you	notice,	all	the	heading	of	the	column	are	into	data	itself......so	you	need	to	add	the	column	headings.To	do	this,	you	need	to	double	click	on	the	header	and	add	a	name,	or	you	can	right	click	and
select	rename	it.The	next	you	need	to	exclude	the	headings	which	you	have	in	the	data	table.Now	open	any	column’s	filter	option	and	unselect	the	heading	name	which	you	have	in	the	column	data	and	click	OK	after	that.Now	our	data	is	ready	to	load	into	the	worksheet,	so,	go	to	the	Home	Tab	and	click	on	the	close	and	load.Congratulations!	you	have
just	combined	data	from	the	different	workbooks	(with	different	worksheets	name	and	without	any	table).At	this	point,	you	have	merged	the	data	into	one	table.But	there’s	one	thing	you	need	to	do……and	that’s	applying	some	formatting	to	it	and	making	sure	that	it	won’t	go	away	when	you	update	your	data.Here’s	what	you	need	to	do…First	of	all,
select	the	column	where	you	have	dates	(as	it	is	formatted	as	number	right	now)	and	format	it	as	dates.After	that,	make	all	the	columns	wide	as	per	the	data	you	have	in	them.Here	you	can	also	format	amount	and	price	as	“Currency”.	But	the	next	thing	is	to	make	this	formatting	fix.For	this,	go	to	“Design	Tab”,	and	open	properties.Untick	“Adjust
Column”	width	and	tick	mark	“Preserve	Cell	Formatting”.Yes,	that’s	it.Now	you	have	a	query	in	your	workbook	which	can	combine	data	from	multiple	files......and	merge	it	into	a	single	workbook......even	if	the	worksheet	name	is	not	the	same	or	if	you	don’t	have	tables.And	yes,	you	have	also	made	the	formatting	fix.	?As	I	said,	POWER	QUERY	is	real
and	if	you	frequently	use	to	combine	data	from	multiple	files	then	you	must	use	this	method……as	it’s	a	ONE-TIME	setup.The	most	important	thing	is	you	when	you	use	power	query	you	can	even	clean	the	data	from	those	files	as	well.I	hope	this	tutorial	will	help	you	to	Get	Better	at	Excel.	But	now,	you	need	to	tell	me	one	thing.Which	method	do	you
use	to	combine	data	from	multiple	files?Make	sure	to	share	your	views	with	me	in	the	comment	section,	I'd	love	to	hear	from	you.	And	please,	don’t	forget	to	share	this	post	with	your	friends,	I	am	sure	they	will	appreciate	it.You	must	Read	these	Next	Puneet	is	using	Excel	since	his	college	days.	He	helped	thousands	of	people	to	understand	the	power
of	the	spreadsheets	and	learn	Microsoft	Excel.	You	can	find	him	online,	tweeting	about	Excel,	on	a	running	track,	or	sometimes	hiking	up	a	mountain.
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